
About This Guide 
 

Page | 1 Spatial NI: AGOL Services - ArcGIS Pro 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Spatial NI 

ArcGIS Online 
Services 

 
ArcGIS Pro 



About This Guide 

Page | 2 Spatial NI: AGOL Services - ArcGIS Pro 

 

Document Version 

Version Purpose for Change Date 

1.0 Creation 01 April 2019 

   

   

 

Software Version 

The guidance in this document has been written for use with ArcGIS Pro 2.3.0. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
  

 

 

© Crown Copyright 2019  

Ordnance Survey of Northern Ireland 
Lanyon Plaza | 7 Lanyon Place | Belfast | BT1 3LP 
https://www.spatialni.gov.uk 
 

https://www.spatialni.gov.uk/


About This Guide 
 

Page | 3 Spatial NI: AGOL Services - ArcGIS Pro 

Contents 
 

About This Guide ....................................................................................................... 5 

What is Spatial NI? .............................................................................................................................. 5 

What is ArcGIS Online? ....................................................................................................................... 5 

Who can gain Access to Spatial NI Content via AGOL? ....................................................................... 5 

How to gain Access to the Spatial NI AGOL? ...................................................................................... 6 

What is ArcGIS Pro? ............................................................................................................................ 6 

New to using ArcGIS Pro? ............................................................................................................... 6 

Accessing Spatial NI .................................................................................................. 7 

Licencing ArcGIS Pro ........................................................................................................................... 7 

Connecting to Spatial NI via ArcGIS Online (AGOL) ............................................................................ 9 

Your AGOL credentials .................................................................................................................... 9 

Getting access to Spatial NI........................................................................................................... 10 

Accepting a request notification ................................................................................................... 11 

Accessing a group .......................................................................................................................... 12 

Logging in from ArcGIS Pro ........................................................................................................... 13 

Creating a New Project ............................................................................................ 14 

Saving a Project ................................................................................................................................. 16 

Finding and Viewing Content ................................................................................... 18 

Spatial NI Basemaps .......................................................................................................................... 20 

Spatial NI Operational Content ......................................................................................................... 22 

Adding Content ............................................................................................................................. 23 

Spatial NI Metadata .......................................................................................................................... 24 

Using Spatial NI Services ......................................................................................... 25 

Symbology ......................................................................................................................................... 25 

Types of Symbology ...................................................................................................................... 26 

Customising Symbology ................................................................................................................ 27 

Querying ............................................................................................................................................ 29 

Selecting Manually ........................................................................................................................ 29 

Select by Attributes ....................................................................................................................... 32 

Select by Location ......................................................................................................................... 34 

3 Band Image Analysis ...................................................................................................................... 36 

4 Band Image Analysis ...................................................................................................................... 41 



About This Guide 

Page | 4 Spatial NI: AGOL Services - ArcGIS Pro 

 

3D Analysis ........................................................................................................................................ 42 

Configuring 3D Terrain .................................................................................................................. 42 

Creating a Scene ............................................................................................................................ 44 

3D Analysis Tools........................................................................................................................... 46 

OSNI Fusion Services ......................................................................................................................... 54 

Querying ........................................................................................................................................ 54 

Snapping ........................................................................................................................................ 55 

Sharing Maps .................................................................................................................................... 58 

Printing .......................................................................................................................................... 58 

Exporting ....................................................................................................................................... 59 

 

  



About This Guide 
 

Page | 5 Spatial NI: AGOL Services - ArcGIS Pro 

About This Guide 
 

This guide has been written to assist you when using web services from the Spatial NI 

ArcGIS Online (AGOL) in ArcGIS Pro. 

Text highlighted in bold are actions that you will need to complete. 

When you see this box… 

 

What is Spatial NI? 

Spatial NI is Ordnance Survey of Northern Ireland’s web mapping platform. It provides 

you with access to not only Ordnance Survey’s authoritative mapping data, but other 

geospatial information from multiple providers across the public and private sectors. 

Components of Spatial NI: 

 

 

What is ArcGIS Online? 

ArcGIS Online is a component of the Esri platform and is part of their geospatial 

cloud.  It enables you to connect people, locations and data using interactive 

maps.  You can work with smart, data driven styles, intuitive analysis tools that deliver 

location based intelligence and share your insights with the world or specific groups.  

 

Who can gain Access to Spatial NI Content via AGOL? 

Access to the Spatial NI content via AGOL is available to all NIMA participants who 

are unable to connect to the Spatial NI NIMA Portal.  

Go Further Box:        

Discover more amazing ways you can use the Spatial NI services,  

OR Top tips for using ArcGIS Pro. 

 

Spatial NI Website 

The Spatial NI website enables 

the public citizen to view and 

interrogate OSNI maps with other 

spatial data. It also contains a 

handy gallery of other mapping 

applications. 

Spatial NI NIMA Portal 

Access the Spatial Data Infrastructure 

(SDI) available to all recipients of the 

Northern Ireland Mapping Agreement 

(NIMA) - (Login is required). 

Spatial NI for INSPIRE 

Spatial NI for INSPIRE provides a 

network of spatial data, accessible 

under the INSPIRE Directive, that 

can be used to promote and support 

environmental protection 



About This Guide 

Page | 6 Spatial NI: AGOL Services - ArcGIS Pro 

 

How to gain Access to the Spatial NI AGOL? 

You will need to have an AGOL account for your organisation and have access to 

administrative privileges. The data is exchanged via a group established on the Spatial 

NI AGOL, which is then shared with specific members of your organisation.  

If after reading this document you would like to know more on how to configure this 

access, email us for advice. 

 

What is ArcGIS Pro? 

ArcGIS Pro is Esri’s next-generation desktop GIS product which provides professional 

2D and 3D mapping in an intuitive user interface.  You can think of ArcGIS Pro as a 

software program that advances visualisation, analytics, image processing, data 

management and integration. 

Easily mash up data from multiple sources to make maps that are as smart as they 

are beautiful.  Use the powerful analytical tools to identify hidden patterns and trends 

in your data. 

We recommend ArcGIS Pro as the optimal desktop software to interact with the Spatial 

NI NIMA Portal. All the analysis of ArcMap just with handy new features including: 

multiple portal connections, project organisation, ribbon based interface and multiple 

active panes. All of these allowing for quick and easy access to the content and tools 

you use. Pro is completely integrated with ArcGIS Online so sharing, viewing and 

accessing data from your online content will be much easier. 

 

New to using ArcGIS Pro? 

Complete Esri's online training to find out how you can make the most of ArcGIS Pro 

and all the new features it offers.  

 

   

mailto:lps.digitaloperationssupport@finance-ni.gov.uk?subject=Information%20Request%20-%20Set%20up%20an%20AGOL%20shared%20group
https://pro.arcgis.com/en/pro-app/


Accessing Spatial NI 
 

Page | 7 Spatial NI: AGOL Services - ArcGIS Pro 

Accessing Spatial NI 
 

Spatial NI contains a wealth of geospatial data from a diverse range of organisations.  

This information can be easily leveraged within ArcGIS Pro to help you complete 

analysis, identify trends and make informed decisions. 

Spatial NI has facilitated two methods by which you can easily leverage content into 

ArcGIS Pro.   

These are: 

 Spatial NI NIMA Portal – A high availability instance of ArcGIS Enterprise which 

offers you a single sign-on experience.  This is facilitated by using Active 

Directory Federated Service (ADFS). 

 ArcGIS Online (AGOL) – Easily access content via your own organisations 

AGOL account.  You will need to have a level 2 named user within your 

organisation to connect via this method. 

 

Licencing ArcGIS Pro 

ArcGIS Pro can be licenced via two methods: 

 Standalone – This licence is deployed during the install process.  Once you 

launch ArcGIS Pro, the software will open and be ready for use. 

 Concurrent – The licence is taken from a licencing portal, either ArcGIS 

Enterprise or ArcGIS Online.  A pop-up will prompt you for your credentials and 

you can check your login status from   in the top right of the ArcGIS Pro 

window. 

 

 

Accessing your AGOL from ArcGIS Pro: 

1. Open ArcGIS Pro, navigate to the Project tab on the ribbon.  

From the side menu, select the Portals tab. Click Add Portal. 
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Continued:  

2. In the dialogue box, enter the URL for your AGOL. Click OK. 

 

3. To Sign In  Right-click on the Spatial NI NIMA portal and select Sign in. 

Enter your AGOL account credentials into the pop-up window. This will 

change the status of the portal to Available: Signed in as …  

4. Set your Active Portal  Only content from your active portal will be 

available in your ArcGIS Pro project. Right-click your AGOL from the list of 

added portals. Select Set as Active Portal.  

 

 

*NOTE: This will place a green tick above the portal symbol     , indicating 

that it is active. This portal will remain the default active portal whenever signed 

into ArcGIS Pro, until manually changed.  

5. Remove a portal  Navigate to the Project tab on the ribbon and select 

Portals. Hover the curser over the Portal link you want to remove. Click 

the red ‘X’ which appears on the right of the portal URL.  
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Connecting to Spatial NI via ArcGIS Online (AGOL) 

To connect to and leverage content from Spatial NI via ArcGIS Online, you will need 

to have a configured level 1 or a level 2 named user account within your organisations 

AGOL. 

 

Your AGOL credentials 

Your AGOL named user account will need to have certain privileges configured.  To 

check this you may need to consult with your organisations AGOL administrator. 

A user for connection to Spatial NI must have the following configuration: 

Role: User (default) 

 

Role privileges: Join external groups 
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Who can see your profile?: Everyone 

 

Getting access to Spatial NI 

Once you have checked that your AGOL account has the correct permissions, you 

will need to select which Spatial NI groups you would like to access from the list 

below: 

Group Name Description Want to Join? 

Environment 
Contains current and historical environment feature 

layers, incl. NI designated sites.         

Geology 
Contains map image layers showing features of NI 

Geology. 
       

Hydrology 
Contains map image layers showing water 

distribution and flooding data.         

OSNI: Elevation 
Contains OSNI Terrain data.        

OSNI: Historical 
Contains historical line drawn and early digital maps 

of NI throughout the 20th century.         

OSNI: Fusion 
Contains dynamic feature layers derived from the 

OSNI Fusion basemap.        

OSNI: Imagery 
Contains the current orthophotography mosaic and 

the individual imagery captured by year.         

OSNI: Location 
Contains pointer services, address information and 

boundaries for NI. 
       

OSNI: Opendata 
Contains the opendata offered by OSNI, including: 

boundaries, raster basemaps and transport network.        

People and Place 
Contains data for social interest including: schools 

playparks, police stations and public areas.        

Statistics  
Contains statistical data from the NI 2011 census and 

deprivation maps.          
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Then contact the Spatial NI Support Team by email, providing the following details to 

be granted access to the correct groups. 

 Your AGOL username 

 The list of groups which you would like to access 

 

Accepting a request notification  

Once, the Spatial NI support team have confirmed your access permissions, you will 

need to accept the group invitation to join the group.  

1. Login to your organisations AGOL.   

2. Click the notifications icon on the top menu bar  View your invitations 

 

3. From the list of invitations, select the AGOL group you wish to join  Click Join 

this group 
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Accessing a group 

The group will now appear in your My Groups tab, within Groups. 

1. Click the group name link to enter the group page, and view content.  

 

*NOTE: Click Leave Group at any time you wish to remove yourself from the group. 

This will have no effect on the group or content within. 
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Logging in from ArcGIS Pro 

1. Within the Portal Groups tab in the Catalog pane, select the name of the 

AGOL Shared group from the list of available groups. This list of groups 

includes all groups of which you are a member on your own AGOL and shared 

groups from another organisations AGOL.   

 

2. Double left-click on the Group name to view only the content within this group. 

You can add the content to your current map by right-clicking and selecting 

Add to current map.  

See section ‘Adding Content from Spatial NI Portal’ (page 22) for opening and adding 

Spatial NI content.  
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Creating a New Project 
 

ArcGIS Pro allows you to store all map elements within one work area. A project 

contains maps, layouts, tasks, and connections to servers, databases, toolboxes, 

folders, styles, and much more. One project can contain multiple maps and scenes, 

and is able to display these at the same time, creating a dynamic workspace. 

Follow the steps below to create a new project: 

1. Upon launching; ArcGIS Pro will display any previously saved projects available 

to open OR the right-hand panel gives options to create a new project. 

Depending on the type of data you will be using, select either;  

a. Scene (Global/Local) for 3D data 

b. Map for 2D data 

c. Blank will not automatically open a map or scene 

 

 

 

 

 

 

 

 

2. When creating a new project, assign a relevant name and storage location 

folder.  

 

3. The new project will open, displaying the Contents and Catalog panes. These 

panes can be moved or closed.  

  

Existing Projects 
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Viewing Multiple Maps: In ArcGIS Pro it is possible to open multiple map 

and scene files within the same workspace. This is very useful when 

viewing the same location using various maps. 

1. Insert a new map or scene, it will appear as a new tab. 

 

2. The tabs can be separated by dragging the tab to the right/left of 

the map pane. This creates a duel viewing workspace. 

 

3. It is possible to connect these two maps displaying the same 

location and/or scale. Click Link Views in the View tab and select 

your desired connection. This means as you move or zoom on 

one map, the other mirrors this change.  
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Saving a Project 

When creating the project, a folder was created either to a custom location or by 

default in ArcGIS  Projects. Any saves will update this folder and will include the 

following information: 

 Items stored in the project such as maps, layouts, tasks, charts, 

geoprocessing history, and animations. 

 Connections to items stored outside the project such as folders, databases, 

servers, toolboxes, locators, and custom styles. 

 A list of the system styles available in the project. 

 Which views are open, and which view is the active view. 

 Your favourite geoprocessing tools and raster functions for the project. 

To save your current project, navigate to the Project tab on the ribbon.  

1. Select the Save tab to save to the current project folder, or Save As to save a 

new project.  

 

 

Quick save:  

To save changes to the project quickly, select the save project icon on 

the quick access toolbar.  
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2. To save a map independent of the project; right-click the Map title in the 

contents pane and select Save as map file. 

 

 

ArcPro Theme:  

You can change the theme of your ArcGIS Pro from the Light theme to 

the Dark theme. This can be good when mapping for long periods of 

time, to reduce eye strain.  

Navigate to the Project tab  Options  General  Application 

Theme  Drop-down menu Dark/Light. 
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Finding and Viewing Content 
 

Spatial NI provides OSNI and third party organisations data via AGOL shared groups.  

It is also possible to gain access to Spatial NI basemaps upon request.  

Inserting a new map/scene: 

1. To insert a New Map/Scene navigate to the Insert tab on the ribbon menu. 

Click the drop-down menu for New Map. 

 

2. To add a new map file to your project, select New Map within this drop menu. 

This type of workspace is primarily used for 2D data (no z values). 

3. Select New Global Scene to open a workspace compatible with 3D data 

viewable on a global scale. Equally select New Local Scene for 3D data within 

a local view, for example a countrywide scale. 
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Rename Your Map:  

Giving your map a descriptive name can make it easier to find 

appropriate content within your projects map storage folder. 

Right-Click the map title within the Content pane, and select Properties. 

 

 

 

*Quick Access: Select the map title within the Contents pane and press 

F2 on the keyboard. Type the new name directly in the Contents pane.  
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Spatial NI Basemaps 

ArcGIS Pro will automatically connect to the basemap gallery from your active 

portal/AGOL account. In most cases this will be the default Esri basemaps. Your 

AGOL administrator can check your basemap settings through the Organisation tab 

 Settings  Map. It is possible to request the gallery of Spatial NI basemaps to be 

configured for use in your own AGOL. Ask your AGOL Administrator to contact Spatial 

NI via email.  

Spatial NI basemaps are a collection of non-editable cached maps, which display 

OSNI data in a variety of styles and scales. The basemap is the lowest layer of the 

map and is used to give spatial context to the feature layers above.  

 

A selection of Spatial NI basemaps are available which are summarised below:  

Basemap Name Description Cache Scales 

(1:250,000) Colour 
A coloured raster map of NI highlighting features such as: 

roads golf courses, settlements, and sites of interest. 
1:550,000 - 

1:120,000 

(1:250,000) Outline 

A black and white outline raster map of NI highlighting 

features such as: roads golf courses, settlements, and 

sites of interest. 

1:550,000 - 

1:120,000 

1:10,000 

A largescale derived raster map showing detailed 

information on features such as roads, fields, water and 

settlements. 

1:20,000 - 

1:5,000 

Activity (1:25,000) 
A series of raster maps tailored to outdoor leisure 

activities centred on six regions of NI (e.g. The Mournes). 
1:30,000 - 

1:10,000 

Discoverer 

(1:50,000) 

A mid-scale raster map giving full coverage of NI showing 

all roads, tourist information and relief. 
1:60,000 - 

1:20,000 

Discoverer 

(1:50,000)(Grid) 

A mid-scale raster map giving full coverage of NI showing 

all roads, tourist information and relief. This includes the 

Irish grid reference lines. 

1:60,000 - 

1:20,000 

Fusion 

A scalable basemap depicting detail from a NI scale to 

the most detailed (derived from OSNI Fusion). This 

includes data from Ordnance Survey Ireland. 

1: 2,000,000 - 

1:500 

Fusion Light 
A grayscale styling of the Fusion basemap. 1: 2,000,000 - 

1:500 

Orthophotography 
High quality 3-band Ariel photography offering a detailed 

birds-eye view of the landscape. 

1: 2,000,000 - 

1:500 

Streetmap 
A detailed raster map showing clear street level 

information for towns and cities in NI. 
1:20,000 - 

1:5,000 

 

*This list is continually being updated as and when new data becomes available.   

mailto:lps.digitaloperationssupport@finance-ni.gov.uk?subject=Spatial%20NI%20-%20AGOL%20Request
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Creating your own Basemap:  

1. To create a basemap using your own layer; navigate to the 

Insert tab on the ribbon. Click on the drop-down menu for New 

Map and select New Basemap. This will open a blank 

workspace.  

 

2. Add data you wish to use as a basemap to this workspace.  

3. Rename your basemap by double left-clicking the basemap 

name in the Contents pane. 

 

4. Save the project. Navigate back to your map and open the 

basemaps menu. Your personal basemap will be available to 

add. 
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Spatial NI Operational Content 

Spatial NI offers a range of OSNI and third party organisations data.  This content can 

be either cached raster or editable vector data.  You can add this data on top of a 

basemap in your map to visualise hidden patterns and trends or complete further 

detailed GIS analysis. This content is available to our AGOL customers via a shared 

group.  

 

Location Units (Irish Grid): 

Spatial NI’s content is projected in Irish Grid. For navigation purposes it 

is important that the live location units displayed at the bottom of the 

map pane is in meters (m) East / North. By default the units are Decimal 

Degrees, to change the default units: 

Project  Options  Units  Location Units. Click OK. 

 

To change the location units for only the map pane displayed: At the 

bottom of the map pane, click the drop-down menu adjacent to the 

displayed units  Select Meters.  
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Adding Content  

To add data, you will need your Map, the Contents pane and the Catalog pane 

displayed.  

1. If your Catalog pane is not displayed; navigate to the View tab on the ribbon 

and select Catalog pane from the Windows section.  

 

2. Within the Catalog pane select the Portal tab; displaying four options;   

 

 My Content: This contains content that you personally own with the connected 

portal.  

 Groups: This contains content that has been shared to you via a group, this 

includes shared group from the Spatial NI AGOL. All groups that you have access to 

will be displayed in a list, double left-click on the group that contains the content you 

wish to add.   

 All Portal: This contains content that is shared within your organisation or that is 

shared with everyone. To see content you will need to search for a key word (tag) 

relating to the layer you want to add. Within a search it will also display anything within 

My Content or Groups.  

 Living Atlas: This contains content owned and shared by Esri.  

 

3. To add content from Spatial NI, Navigate to the groups tab of the portal and 

double-click on the title of the shared group you have been added to. From the 

list of displayed content; right-click on the desired layer and select Add to 

Current Map OR drag and drop the layer into the Map pane or Contents 

pane. The feature layer will appear as the top layer in the contents list along 

with any symbology.  
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Spatial NI Metadata 

Metadata provides information about mapping layers, including: owner, contact 

details, creation date, data origins, and legal restrictions of use.  

 

Spatial NI uses the INSPIRE metadata standard for all hosted content. To view 

metadata for Spatial NI Content; access via your AGOL web interface, within the 

AGOL shared group. The content item page will contain the metadata from Spatial NI. 
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Using Spatial NI Services 
 

Spatial NI are aware that analysis is a central feature to any GIS project.  For some of 

our operational services, we offer you the ability to complete additional GIS functions 

depending on the type of service being used.  These functions are explained below. 

Service Type Description Analysis 

 
Tile Layer 

Pre-rendered map raster tiles. You will not be able to complete any 

analysis using these services.  

 

Imagery 

Layer 

Dynamically displayed raster 

data. 

You will be able to complete imagery 

based analysis on these services. 

 

Feature  

Layer 

A feature layer is a grouping of 

similar geographic features (e.g. 

buildings, land parcels or 

roads).  Features can be points, 

lines or polygons. 

You will be able to view, edit, analyse, 

and execute queries against features 

and their attributes.  You will also be 

able to change the layers symbology. 

 

Map Image 

Layer 

A collection of map cartography 

based on vector data.  Map 

image layers are dynamically 

rendered image tiles. 

You will not be able to complete any 

analysis using these services. 

 

Symbology 

This is the symbols used to display data on a map, including: colour, size and format. 

Only the symbology of a feature layer is customisable. If you are using a map service 

or imagery layer from the portal you cannot change the symbology of any features.  

To edit the symbology of a layer;  

1. Right-click on the layer title in the contents pane. From the drop-menu select 

Symbology. 
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2. You can also, left-click on the displayed symbology (viewable when the layer 

is expanded within the contents pane). This will open the symbology pane.  

 

 

Types of Symbology 

For basic use the tab labelled Primary Symbology is sufficient for customising the 

symbol and style. Within the Primary symbology tab you are given a drop-down 

menu to select the type of symbology that will best display your data. A brief 

descripting of each symbology type is outline below: 

 Single symbol - Single symbol symbology applies the same symbol to all 

features in a layer. This symbology is used for drawing a layer with just one 

category such as county boundaries. 

 Unique values - Unique values symbolize qualitative categories of values. 

Examples include habitat types, planning zones, voting preferences, and soil 

classifications. 

 Graduated colours - Graduated colour symbology is used to show a 

quantitative difference between mapped features by varying the colour of 

symbols. Data is classified into ranges that are each assigned a different colour 

from a colour scheme to represent the range. 

 Graduated symbols - Graduated symbols are used to show a quantitative 

difference between mapped features by varying the size of symbols. Data is 

classified into ranges that are each then assigned a symbol size to represent 

the range. 

 Unclassed colours - While graduated colours symbology distributes data into 

discrete classes with unique symbols, unclassed colours symbology distributes 

a colour scheme evenly across features. 

 Heat Map (point feature layers only) - Heat map symbology draws point 

features as a representative surface of relative density. Use heat map 

symbology when many points are close together and cannot be easily 

distinguished. 

 Proportional symbology - Proportional symbology is used to show relative 

differences in quantities among features. 
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 Dot Density (polygon feature layers only) - Dot density symbology is one way 

to represent quantities within polygons on a map. With dot density symbology, 

the data you symbolize is not classified. 

 Dictionary renderer - Dictionary symbology is used to symbolize layers using 

a dictionary of symbols configured with multiple attributes. This approach is 

used when symbol specifications lead to many symbol permutations that would 

be inappropriate for unique value symbology. 

 

Customising Symbology 

After selecting the correct symbology type, ArcGIS Pro will categorise your data to 

match the format. Depending on the symbology chosen a unique set of options will 

appear. This example will focus on single symbol symbology.  

To find help on how to configure any other type of symbology, explore the ArcGIS Pro 

Symbology Help. 

Within the symbology pane: 

1. Left-click on the current displayed symbol to edit the size/colour/shape.  

2. A label is not required. However, if you would like a label to appear in the 

contents pane next to the symbol, enter it into the label box.  

 

3. Within the Format Point/Polygon Symbol pane the Gallery tab allows you to 

change the symbol itself. Default symbols are suggested for public map 

features such as an airport. If using 3D data there are also options for 3D 

symbols. As you change the symbol, the changes will automatically be updated 

in the map pane.  

http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/symbolize-feature-layers.htm
http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/symbolize-feature-layers.htm
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4. When your symbol has been selected you can fully customise it by selecting 

the Properties tab. Here you can change the fill and outline colour, symbol 

size, or insert your own symbol from file. Click Apply when all settings are 

correct to see the new symbology on the map.  

 

*NOTE: The options within these panes will vary depending on the type of symbology 

selected and whether it is a point/line/polygon (single symbol).   
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Querying  

Query expressions can be used on feature layers or on layers that contain attributes 

to select a subset of features according to information contained in the attribute table 

or from a spatial relationship.  

Querying data can be a useful analysis tool as it can focus your target area by 

isolating records.  

 

Selecting Manually 

1. Navigate to the Map tab on the ribbon. 

2. Within the selection section, click the Select drop-down menu. This allows 

you to manually select features by drawing on the map.  

 

3. Choose the type of selection, and draw this shape on the map. Left-click and 

drag to enclose the targeted area. All the features within this area or that 

intersect with the selection boundary will be selected. This is indicated by a 

colour change to the features symbols.  
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4. You can then view the attributes of the selected features within the attribute 

table. To view the selected features; Right-click on the feature layer in the 

contents pane and select Attribute table.   
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5. The bottom left corner of the attribute table shows the number of selected 

attributes as part of the total. Click the highlighted symbol to only display the 

selected attributes.  

 

6. Further options are available from the Selection menu, Right-click the feature 

layer within the contents pane, and select Selection. The highlighted option 

allows you to create a new layer containing only the selected features, including 

the content within the attribute table.  
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Select by Attributes 

Select by Attributes allows you to select features based on an expression of desired 

parameters.  

1. Click Select by Attributes from the Selection menu in the Map ribbon tab. A 

new pane will open, titled Geoprocessing.  
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2. Within the Parameters tab, check the Input Rows is set to the correct layer 

and Selection Type is also correct. To build an expression click Add Clause. 

An expression is a good way to isolate features with similar data or for data 

between certain threshold values. Example expression:  

 

This expression will select all attributes with ‘ABBEY’ within the ‘WARDNAME’ field.  

This could be combined with another expression to refine the search further.  

3. Click Add, then Run when expressions are completed. If your expression has 

run correctly you will see the successful completion notice at the bottom of the 

pane, and the results will be displayed on the map.  
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Select by Location 

The Select by Location tool lets you select features based on their location relative 

to features in another layer. To use this tool you need at least two feature layers. 

1. Click Select by Location from the Selection menu in the Map ribbon tab. A 

new pane will open, titled Geoprocessing.  

 

 

2. For example, I have selected a ward and want to know the names of all the 

townlands that are completely within this ward boundary. 
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The Select by Location pane would be configured as follows: 

 

3. Within the townlands attribute table I am able to see that five records have 

been selected. These are the townlands that are completely within the selected 

ward boundary.  

This example can be applied to many types of datasets. Another example would be 

finding an amount of data points within a boundary.  

 

Selected attributes can be exported to a new layer.  

1. Right-click the layer that has selected attributes within the Contents pane. 

Hover over Selection, then click Make Layer From Selected Features.  

2. A new layer will appear in the Contents pane. This can be renamed 

appropriately.   
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3 Band Image Analysis 

‘OSNI - Orthophotography (3 Band)’ is a dynamic service derived from all the available 

orthophotography, with the capability to query.   

The orthophotography is structured with seamlines which includes information for the 

year and specific date that a single image was taken. To query this information in 

ArcGIS Pro: 

1. Add the image layer ‘OSNI - Orthophotography (3 Band)’ located within the 

group ‘OSNI: Imagery’. Right-click and select Add to Map.  
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*NOTE: To view this layer the map must be at 1:20,000 scale or below.  

To query this layer you can either add a definition query or select by attributes. 

2. Definition query – This will clip the orthophotography images that identify with 

the query parameters. The images can be queried against flight date or year. 

Right-click the orthophotography (3Band) in the Contents pane. Select 

Properties. 

 

3. Select the Definition Query tab, then click New definition query.  
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4. Write your query expression within the drop-menus, click Add, then either add 

another clause or click Apply.  

 

5. Click OK to finish. The query will run automatically and display only the images 

that match the definition query. These records will also be the only ones shown 

within the attribute table.  

 

6. Select by Attributes – This will isolate the records that match the query 

expression within the attribute table and highlight them on the map. Click Select 

by Attributes within the Map tab.  
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7. Within the Geoprocessing pane, select OSNI Orthophotography (3Band) as 

the Input row. Add an appropriate expression for the Clause and click Run. 

 

8. Right-click on the layer within the Contents pane and select the Attribute 

Table. Show selected records. Records matching the expression will be 

highlighted.  
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9. Right-click the box to the left of the record you are interested in viewing. From 

here you can Pan To the specific image and select a Pop-up to view the 

information about the image in a pop-up window.  
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4 Band Image Analysis 

Similar to the 3Band orthophotography layer, OSNI – Orthophotography (4Band) is a 

service derived from all the available 4Band orthophotography, which can be queried. 

To query this layer when added to ArcGIS Pro follow the same steps as the 3 Band 

Image Analysis. 4Band ortho-photos are multispectral images that can show the near 

infrared band, with the added ability to run analysis, such as Normalised Difference 

Vegetation Index (NDVI).  

1. To view the orthophotography infrared bands, Navigate to the Appearance tab 

within the Image service layer (this only appears when the image service is 

selected in the Contents pane). Click the drop-down menu Band Combination, 

and select Colour Infrared. 

 

2. The Infrared band can distinguish between healthy and unhealthy vegetation, 

urban areas, crop types, bodies of water and forested areas.  

*NOTE: An unsupervised classification can be used to easily separate these 

categories. Find out more. 

 

  

Forested area 

Healthy vegetation 

Quarry 

Body of water 

https://pro.arcgis.com/en/pro-app/help/analysis/image-analyst/overview-of-image-classification.htm
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3D Analysis 

Spatial NI have developed a terrain service for Northern Ireland. This shows the 

elevation of the bare Earth without structures, such as buildings. The ‘OSNI Terrain’ 

layer is a 1m resolution surface which has been derived from the enhanced 60m DTM.   

The terrain layer only contains elevation data, to add context an imagery layer will 

need to be draped over the terrain. This can be done using an ArcGIS Pro scene. 

Configuring 3D Terrain 

1. Insert a New Local Scene to begin building a 3D map. Click the drop-down 

menu for New Map within the Insert tab. 

 

2. By default the scene will include the default basemap in 2D Layers and will set 

the ground as WorldElevation3D/Terrain3D. Remove both of these layers from 

the scene. Right-click the layer title in the Contents pane and click Remove.  
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3. To add the OSNI terrain, a new surface needs to be added. Right-click 

Elevation Surfaces in the Contents pane and select Add Elevation Surface. 

 

4. Right-click Surface 1 within the Contents pane and select Add Elevation 

Source. 

 

5. Make sure you are connected to the NIMA portal. A pop-up window will allow 

you to search the portal to find the OSNI Terrain imagery layer, which is held 

in the ‘OSNI: Elevation’ group. When selected click OK.  
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Creating a Scene 

The OSNI Terrain is now set as Surface 1 in the Contents pane. At this stage nothing 

will appear in the map pane. Add imagery to complete your 3D map. 

1. Add the OSNI Orthophotography from the NIMA portal via the Catalog pane.  

 

2. To drape the orthophotography over the terrain you need to set the layers 

ground source to be the OSNI Terrain. Right-click the orthophotography layer 

title in the Content pane and select Properties.  
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3. Within the Properties window, navigate to the Elevation tab and click the 

‘Features are’ drop-down menu. Select On Custom Elevation Surface. 

 

4. Set Custom Surface to Surface 1, which contains the OSNI Terrain layer. 

Click OK. 

 

5. Zoom in to a scale below 1:20,000 to activate the terrain.  

 

*NOTE: Because these layers are now linked, the orthophotography may not draw at 

scales beyond 1:20,000. If you need to reposition your map, temporally turn off the 

Terrain layer and the orthophotography will redraw.  
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3D Analysis Tools 

The OSNI terrain data can be used to analyse the height of the bare earth above sea 

level at any given point, due to its Z value. Outlined below are a few techniques that 

can be used in ArcGIS Pro to enhance/analyse 3D data.  

Contour Lines  A line on a map joining points of equal height.  

1. Before adding contour lines, add the OSNI:Terrain raster service to your 

Contents pane, then Order as shown below:  

 

2. Navigate to the Analysis tab on the ribbon and select Raster Functions. 

 

3. Within the Raster Functions pane System, select the Surface drop-down 

menu 
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4. Select Contour for the list of available surface tools.  

 

5. Within the Contour Properties pane; set the Raster as OSNI – Terrain, 

Contour Type as Contour Lines, Contour Interval as 10 (m), and Nth 

Contour Line in Bold as 5. These settings will draw a contour line every 10 

meters and will highlight in Bold every 50 meters. When complete click Create 

new layer.  
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6. The Contour layer will appear in the Contents pane, make sure that it is the 

uppermost layer. Right-click the Contour layer and click Properties. In the 

Layer Properties pane navigate to the Elevation tab and set the custom 

elevation surface to Surface 1 (OSNI Terrain). Click OK. 
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7. The contour will now appear draped over the elevated orthophotography. The 

contour symbology can be changed to personal preference via the Symbology 

pane.  

 

 

 

Hillshade  A greyscale 3D representation of the surface, with the sun's relative 

position taken into account. 

1. Follow steps 1-3 of Contour lines. Then select Hillshade from the list of 

available surface tools.  
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2. Within the Hillshade Properties pane; set the Raster as OSNI – Terrain, and 

customise the Azimuth and Altitude according to the purpose for analysis. The 

example layer below has set the suns position to 45o above the horizon and 

from NW. Then click Create New Layer. 

*NOTE: Altitude is the sun's angle of elevation above the horizon and ranges from 0 

to 90 degrees. A value of 0 degrees indicates that the sun is on the horizon. Azimuth 

is the sun's relative position along the horizon (in degrees). This position is indicated 

by the angle of the sun measured clockwise from due north. An azimuth of 0 degrees 

indicates north. 

 

 

Multidirectional Hillshade:  

Multidirectional hillshade improves terrain visualization. It combines light 

from six different directions to represent an enhanced visualization of 

the terrain and to improve the appearance of regions with low relief. It 

improves the balance between the over-exposed and shadow areas of 

the map. 

Traditional hillshade result:   Multidirectional hillshade result: 
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3. The Hillshade needs to be configured to drape over the terrain. Right-click the 

Hillshade layer and click Properties. In the Layer Properties pane navigate to 

the Elevation tab and set the custom elevation surface to Surface 1 (OSNI 

Terrain). Click OK. 

 

4. Order the Contents pane as below to view the Hillshade for analysis. Note that 

the hillshade is only visible with the Orthophotography if the layer is made 

partially transparent.  
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Slope  Represents the rate of change of elevation from one pixel value to its 

neighbours. It's the first derivative of a DEM/DTM. By default, the slope appears as a 

grayscale image. This can be modified to a colormap representation.  

1. Follow steps 1-3 of Contour lines. Then select Slope from the list of available 

surface tools.  

 

2. Within the Slope Properties pane; set the Raster as OSNI – Terrain. Then 

click Create New Layer. 

*NOTE: Scaling options  Degree: The inclination of slope is calculated in degrees. 

The values range from 0 to 90. Scaled: The inclination of slope is calculated the same 

as Degree, but the z-factor is adjusted for scale. It uses the Pixel Size Power and Pixel 

Size Factor values, which account for the resolution changes (scale) as the viewer 

zooms in and out. Percent Rise: The inclination of slope is output as percentage 

values. The values range from 0 to essentially infinity. A flat surface is 0 percent and 

a 45-degree surface is 100 percent. 

 

 



Using Spatial NI Services 
 

Page | 53 Spatial NI: AGOL Services - ArcGIS Pro 

3. The Slope needs to be configured to drape over the terrain. Right-click the 

Slope layer and click Properties. In the Layer Properties pane navigate to 

the Elevation tab and set the custom elevation surface to Surface 1 (OSNI 

Terrain). Click OK. 

 

4. The slope layer will default in greyscale, however analysis lends itself better to 

a colour ramp with multiple classifications. See below for styling and layer order.  
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OSNI Fusion Services 

The dynamic OSNI Fusion services are individual feature classes derived from OSNI 

Fusion. These individual feature classes can be added to ArcGIS Pro, queried and 

used for editing purposes. The services are available within the OSNI:Fusion group.  

*NOTE: The dynamic Fusion services are only viewable at 1:5,000 scale or below.   

You can choose to add an individual layer that you wish to query. However, this may 

appear out of context and it may be more beneficial to add all the individual layers 

before editing. For viewing purposes it is important that these layers are listed in the 

correct order in the Contents pane. List as follows (uppermost – lowest): 

 OSNI - Fusion: Feature Perimeter 

 OSNI - Fusion: Buildings 

 OSNI - Fusion: Structures Line 

 OSNI - Fusion: Structures Polygon 

 OSNI - Fusion: Transport Casing 

 OSNI - Fusion: Transport Non-Vehicular 

 OSNI - Fusion: Water Tidal Measure  

 OSNI - Fusion: Water Course Line 

 OSNI - Fusion: Water Course Polygon 

 OSNI - Fusion: Standing Water Line 

 OSNI - Fusion: Standing Water Polygon 

 OSNI - Fusion: Ground Cover (Vegetation) 

 OSNI - Fusion: Ground Cover (Man-made) 

 OSNI - Fusion: Ground Cover (Bare Soil) 

 OSNI - Fusion: Land Parcel 

 OSNI - Fusion: Geographic Extent 

 OSNI - Fusion: Ireland Sea 

 

Querying 

All the dynamic Fusion services can be queried according to a field within the attribute 

table. Select the desired layer in the Contents pane and right-click to open the Attribute 

table. Change to the field view to see the data available to query. 

Either add a definition query to the feature layer or select by attributes to isolate a 

select set of records. See ‘Querying – 3 Band Image Analysis’ page 36 - 40 to get a 

step by step guide.  
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Snapping 

Snapping is a tool used to assist drawing features on a map, in relation to existing 

points, lines or polygons. To create new features you first need to create a new file 

geodatabase and feature class (see Go Further Box). The new feature can be set to 

snap to a features: point, end, vertex, edge, mid-point, intersection or tangent.  

1. To turn snapping on, highlight your new feature class in the Contents pane. 

Navigate to the Edit tab on the ribbon and select the Snapping drop-down 

menu. Click the icon for Turn snapping on.  

  

The highlighted icons show the active snapping functions. Click and icon to 

select/deselect the function.  

2. To create a new feature, click Create within the Edit tab on the ribbon.  

 

3. The available features will appear in the Create Features pane. Shown below 

is the icon to create a polygon. 
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4. In the Map pane, hover over the edges or corners of a map feature to see the 

snapping possibilities. This will display the name of the layer you are targeting 

and the type of snap.  

 

5. When drawing a feature you can use these snap points to seamlessly connect 

your new feature with an existing map feature.  
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Creating a New File Geodatabase:  

A file geodatabase is stored within your current project in ArcGIS Pro. It 

is a type of database that allows you to create your own feature classes 

and content within.  

Right-click Databases within the project tab of the Catalog pane and 

select New file Geodatabase. A pop-up window will require you to 

enter a name for the new geodatabase, then click Save. 

 

Click the drop-menu for Databases to see the new geodatabase (.gdb). 

 

To create features within this gdb, Right-click the geodatabase name 

and select New  Feature Class.  
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Sharing Maps 

Within ArcGIS Pro data can be shared as a complete map package containing 

originating data links or as exported individual maps.  

 

Printing 

See below for printing services within ArcGIS Pro: 

1. To print a snapshot of you map as its current view within the map pane, select 

Print from the Share tab on the ribbon menu. This will open a basic print 

configuration window linked to your default printer.  

 

2. To print or export your map embedded within a layout; navigate to the Insert 

tab on the ribbon menu, and select New Layout within the Project section.  

Finding saved maps:  

A map/scene can be closed and not deleted from a project. As long as 

the project has been saved when the map was open it will be saved 

within the project folder. 

This can be accessed within the Project tab of the Contents pane. 

Open the Maps drop menu to view all saved maps. Right-click the 

desired map to open/edit/delete.  
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How to configure a map layout Esri. 

 

Exporting 

After you've created a map or layout, you can export to several industry-standard file 

formats. 

 Vector Formats: EMF, EPS, PDF, SVG, and SVGZ 

 Image Formats: BMP, JPG, PNG, TIFF, TGA, and GIF 

 

1. To export only the view within the map pane, as one of the raster image 

formats;  

 

https://pro.arcgis.com/en/pro-app/get-started/add-maps-to-a-layout.htm
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2. Enter the file name, then set the File Type, Resolution and Colour Mode. Click 

Export.  

 

 

To export a package that contains both the layer(s) and the data/properties embedded, 

your data can be exported as a project, map, or layer package. To find out more about 

these and what information is shared follow the Link. 

1. To export a project as a project package; navigate to the share tab and click 

Project.  

 

2. To export a project as a map package; navigate to the share tab and click 

Map. Make sure that your workspace is currently highlighting the map and 

data that you are wanting to export.  

 

https://pro.arcgis.com/en/pro-app/help/sharing/overview/introduction-to-sharing-packages.htm
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A new pane will open when exporting a package, to allow configuration of settings.  

 

 

 

 

Exporting directly to your AGOL:  

Publish a map to your AGOL. The data layers will be published as new 

web layers and will be included in a web map service along with the 

selected basemap and any pre-published layers.   

 

A new pane will open to configure export settings. 

*Note: To do this you must be signed into you AGOL as the Active 

Portal, and your profile must have permissions to publish content.  
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